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COPYRIGHT AND TRADEMARKS
IDville © 2024. All rights reserved.

Users must observe the copyright regulations applicable in their country. This manual must not be photocopied, 
translated, reproduced or transmitted, in whole or in part, for any reason and by any electronic or mechanical means
whatsoever without the express written consent of IDville. 

All the information contained in this document is subject to change without prior notice. IDville cannot be held liable 
for any errors that may be found in this manual, or for any loss or damage arising accidentally or as a result of
dissemination or use of this manual. 

WARRANTY

Refer to the warranty notice for warranty terms and conditions and limitations. It is available on idville.com.

Register online at idville.com  to receive our special offers and general information. 

ENVIRONMENTAL INFORMAT ION
IDville is committed to helping the environment by reducing the energy consumption of its products.

The manufacture of the equipment that you have purchased required the extraction and use of natural resources. 
It may contain materials that are hazardous to health and the environment.
materials into our environment and reduce the pressure on our natural resources, we recommend that you use 

To prevent the dispersal of such

existing collection systems. These systems appropriately re-use or recycle most of the materials in your end-of-life
equipment. For more information on collection, re-use and recycling systems, contact your local or regional waste
management body. For more information, visit our website at idville.com  or send an email to support@idville.com..

ICONS
The following icons are used in this manual to highlight important information:

NOTE

!
Indicates that failing to take the recommended action is liable to damage the printer

A video showing the procedure is available on idville.com
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ABOUT YOUR NEW PRINTER
Thank you for choosing an IDville printer. Using your new printer, you will be able to create a wide variety of high-
quality cards and badges which can be printed in various thicknesses, colors and styles. This printer uses consumables
and accessories available from IDville. For further details and view all technical specifications, visit our website.  

Certifications and declarations of conformity:

CE, UKCA, ICES, VCCI, BIS, CCC, KC, EAC, ROHS, 

FCC (Evolis contact: Evolis, Rising Sun Mills, 188 Valley St., Suite 421, RI  02909 Providence, evolisnortham@evolis.com)

Icons on the printer label:

Evaluation for apparatus only based on altitude not exceeding 2000m, therefore it’s the only
operating condition applied for the equipment. There may be some potential safety hazard if the
equipment is used at altitude above 2000m.  

Evaluation for apparatus only based on temperate climate condition, therefore it’s the only operating
condition applied for the equipment. There may be some potential safety hazard if the equipment is
used in tropical climate region.

Reminder to use existing collection facilities.

Dimensions

• Printer (HxWxD) without locking system and with 100-cards feeder: 246,2x 204.95x 381.2mm

Weight

4.11 kg

Connectivity

USB (1.0, 1.1, 2.0, 3.0), Ethernet, Wi-Fi (option)

Environmental Conditions

• Standard operating temperature: 15° C / 30° C (59°F / 86°F)

• Min / Max operating temperature and humidity rate: 0° / 40° C (32°F / 104°F) and 20% to 65% non-condensing

• Min/max storage temperature: –5° C / +70° C (23°F / 158°F)

• Storage humidity: 20% to 70% without condensation

• Operating ventilation: free air

Electrical Information

• Power supply unit: 100-240 Volts A C, 50-60 Hz, 1.5A

• Printer: 24 Volts D C, 2.5A
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1. GETTING STARTED
UNPACKING
Your printer is supplied with several accessories that we ask you to look at closely.

This list may vary depending on your location.

The printer is shipped in special packaging designed to prevent any damage in transit. If you notice any visible
damage, do not hesitate to contact the shipper and immediately inform your IDville dealer, who will tell you the 
procedure to follow.  

IDville takes great care over the quality of its packaging and we ask that you keep this packaging somewhere clean
and dry.

!
The full original packaging (outer box, inner wedges and protective bags) is required in the event that
the printer is returned. If the printer is returned without its original packaging and components are 
damaged in transit, these components are no longer covered by the warranty. You will be charged for
new packaging for shipping the printer back to you.  

Accessories supplied with your printer:

• Power supply unit – FSP type FSP060-RAAK3

• Mains power cable

• USB cable

• Reject box/Rear output hopper

• Starter cleaning kit

• Quick installation guide

• Card designing software 

!
If any of these components are missing, please contact your IDville dealer.

Use only the power supply unit supplied with your IDville printer.

Use only the USB cable supplied with your IDville printer.

NOTE The IDville printer must be placed in a dry location, protected from dust and drafts but well-ventilated. 
Make sure to keep your printer on a flat, sturdy surface able to bear its weight. 
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DESCRIPTION OF THE PRINTER AND ITS FUNCTIONS

!

A

B

C

D

E

A. Card input feeder (100 cards)

B.  Internal output hopper

C. LCD Screen (option)

D.  Power button

E. LED Control Panel

NOTE If the printer is equipped with an LCD screen, refer to the corresponding user guide for more
information.

Access to the side panels of the machine and the option module fitting/removal areas is restricted
to your retailer/installer or to experienced users. Always disconnect the machine from the power
supply (unplugged) performing work on it.
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K
J

I

H

G

F

L

N

Protective cover

O

M

F.

 

Place for reject box (See "Managing the reject box/rear output hopper", page 18) 

G. Location for security locking (option)

H. Power cable socket

I. Ethernet connector 

J. USB socket (type A)

K. USB socket (type B)

L. Cleaning Roller

M. Side panel opening mechanism

N. Thermal print head with protective cover 

O. Card thickness adjustment gauge
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P
Q

R
S

P. Printer serial number label

Q. 

R. Location for double-sided printing activation key (option)

S. Side panel opening mechanism
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INSTALLATION 

Connecting the Printer Power Supply Cable

!
The printer must be connected to a properly protected and earthed electrical installation.

FI: Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan.

NO: Apparatet må tilkoples jordet stikkontakt.

SE: Apparaten skall anslutas till jordat uttag.

DK: Printeren skal tilsluttes til en korrekt beskyttet og jordforbundet el-installtion.

• 

• Next, plug the end of the power cable into an earthed power socket.

The printer is powered on: the control panel lights up showing the printer is working properly. If the control panel
does not light up, please check the installation.  

!
Before attempting maintenance, make sure the power cable is unplugged. For your personal safety,
ensure that the cable and power supply unit remain easy to access, especially in case of emergency.

NOTE To save energy, the printer automatically switches itself to standby mode after 10 minutes of 
inactivity. The printer switches to hibernation mode after 30 minutes in standby mode. The standby
settings can be configured in the IDville Premium Suite. In standard standby mode, sending a print
request restarts the printer and briefly pressing the control button (for 1 second) exits the printer from
hibernation mode.
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Installing IDville Premium Suite

It includes:

• A supervision of printers: printer status information, remaining ribbon capacity, etc.

• A powerful tool for printer settings

• 

• A printer management and maintenance station

• A series of wizards to guide you through cleaning and encoding operations, etc.

• An encoding station (magnetic encoding, etc.)

• A diagnostic tool

To install the print driver:

1. Go to the link dedicated to the driver (idville.com/infinity-tech-support).

2. Download and launch the driver: IDville Premium Suite .

3. A program guides you through the entire installation process. It is possible to select Standard or Minimal
installation: standard installation is recommended as it includes notification and supervision features. 

4. At the end of the installation process, you need to restart the computer.

5. Connect your computer to the printer trough the USB cable. 

!
Do not connect the USB data cable before the installation of the printer driver is complete. Follow 
the instructions of the wizard carefully.

IDville Premium Suite is an all-in-one driver software solution, which enhances the user experience by making  
interaction between printer and computer more intuitive. Its advanced features automate printer configuration.
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Connecting to a network

All IDville printers can be fitted with a TCP/IP network connection. This function is available as standard on the
Infinity. Out of the box, the printer comes configured in DHCP mode (Dynamic Host Configuration Protocol), which
means that its IP address is supplied by the network.

In addition to these basic settings, the network administrator has the option of configuring the printer differently in
order to comply with the constraints imposed by the corporate LAN:

• Printer connected in a subnet, in DH CP mode

• 

• 

The Ethernet connection wizard available in IDville Premium Suite automatically detects all installed IDville printers.

• IP address of the printer

• Subnet mask

• Gateway

• WINS server

NOTE

! Changing the printer’s basic settings without prior knowledge of the layout of the LAN in question
or without genuine technical knowledge may result in a malfunction of the printer, and may even
extend to more widespread failure of all or part of the LAN. Contact your System and Network-
Administrator before connecting to or changing the settings for your local area network. For further
details, refer to the Network Administrator Manual 

IDville printers fitted with a TCP/IP network interface have an embedded http server.
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Ribbons
IDville ribbons optimize your printer’s operation and avoid causing damage to it. The use of ribbons from other
suppliers may damage the printer and voids the manufacturer’s warranty for the printer. For optimum print quality, 
IDville recommends that the printer is fully cleaned every time the ribbon is changed. See "Printer cleaning", page 51.

Fitting the ribbon

NOTE The printer automatically recognizes the ribbon inserted. 

1. Open the cover. 2. Insert the ribbon as shown. 3. 

NOTE Infinity ribbons are different from Primacy ribbons. They cannot be swapped. 

Close the cover and press
until a click is heard.
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Inserting Cards

NOTE

Use only the card types recommended by IDville.
Do not touch the printable surface of the cards to preserve print quality.

Keep your cards protected from dust.

100
x0.76mm

1. Open the card feeder. 2.  Insert the cards, a maximum of 100 cards 

positioned as illustrated in the diagram.

3. Close the feeder.
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Removing printed cards
Once the print cycle is complete, cards are delivered into the output hopper below the card feeder. 

This output hopper is designed to collect printed and/or encoded cards. 

The output hopper has a maximum capacity of 100 x 0.76mm cards. 

100
x0.76mm

NOTE If the locking option is installed, maximum capacity is reduced to around 50 x 0.76mm cards.

12Call us at: 1.866.438.4553 or visit: idville.com



Adjusting card thickness 
The printer is equipped with a manual card thickness adjustment mechanism which can be reached
through the card feeder when open. The printer accepts cards between 0.25mm and 1.25mm thick (10 to 50mil). 
The factory setting is 0.76mm.

Open the card feeder and
remove cards if necessary.

Adjusting the thickness of the cards
used by moving the gauge from right
to left to the desired card thickness.

Close the feeder.

To adjust card thickness: 

1 2 3
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Managing the reject box/rear output hopper

The reject box can hold 50 cards (0.76mm - 30mil).

50
x0.76mm

To empty it, open the box and remove the cards in it.
It is recommended to empty the reject box regularly.

NOTE The reject box can be used as a hopper to optimise the production flow of cards when continuous
ribbons are used. Preloading helps optimise the production flow. To activate this feature, go to
IDville Premium Suite and click the printer name>Printer settings>Printing>Resolution and Speed>
Enable automatic card preloading.
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2. MANAGING PRINT SETTINGS
ACCESSING SETTINGS

NOTE Contact IDville tech support for advice and assistance before making any change of settings.

To access this application:

1 Double-click on IDville Premium Suite shortcut or, from the Start menu, All programs>IDville Card-
Printer>IDville Premium Suite.

The application displays all connected IDville printers. Select the desired printer.

Go to Printer Setting to change the settings.

 

2 

3
 

NOTE On Macintosh platforms, refer to Macintosh driver User Guide. 

IDville Premium Suite enables changes of specific predefined setting through its user-friendly interface on Windows
platforms.
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Go to Overlay tab to manage the areas of the card
to cover with overlay.

Go to Colors tab to manage black dots on the card

Resolution and Speed tab: change the resolution
if needed.

Go to Card input/output and select the adequate
options.

Click on Display advanced settings (on the right
part of the window) to make more precise
parameters visible.

Go to Card tab and select the orientation:
Landscape or Portrait.

Go to Ribbon tab and click on Enable duplex
printing to use the double-side printing feature.

ESSENTIAL SETTINGS
Once the ribbon is installed, the ID Maker printer automatically adapts its parameters and settings to suit the ribbon.

Action Setting in IDville Premium Suite
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3. PRINTING AND INTERACTING
    WITH THE PRINTER

PRINTING A CARD

 

NOTE For more information, refer to the knowledge base on idville.com or ID Maker embedded Help.

On TextEdit 

1. Open TextEdit application

2. Go to File>Page Setup>Paper Size> Manage Custom Sizes

3. Click on + and add a new format as follows:

    width: 55mm, height: 86mm, top: 0mm, left: 0mm, right: 0mm, bottom: 0mm

4. Save the new format with the name Card and click on OK  

5. Close text edit

6. Go to System Preferences and select Printers and Scanners. On Default paper size, select Card

7. Go back to TextEdit and design your card. 

8. Click on File>Print and select Infinity printer.

On ID Maker

On Microsoft Word

1. Open ID Maker application and select CR80 card type.

2. The card design window is displayed, You are ready to customise your card by adding the various items that go to

    make up a card: logo and illustration, identification photo, fixed and variable texts, barcode, etc.

3. Click on File>Print, select Infinity printer and click on Print.

1. After having set the ID Maker printer as the default:

 • Start the MS Word applicaiton.

 • Select Landscape in the Orientation section.

 • Change the size of your document by selecting the type CR80 (or by customing the document with the

    dimensions 8.6cm x 5.4cm and margins of 0.1cm).

2. Customise your card by addind the various items that go to make up a card: logo and illustration, identification-

    photo, fixed and variable texts, barcode, etc.

3. Click on File>Print, and then on Print.

A large number of applications allow documents to be printed (for examply MS Word, MS Access, MS Excel,

MS PowerPoint). Read the following examples to gain familiarity with the layout of a card and configuration of its

formatting and printing.
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USING THE CONTROL PANELS

LED Control panel

CARDS

   • No cards in the card feeder. 

Put cards back into the feeder - 
the process starts again.

   • Card loading error.

Check cards have been loaded.
for any other problems contact
tech support.

RIBBON

   • No ribbon in the printer. 
   • End of ribbon.
   • The ribbon is not correctly fitted. 
   • The ribbon is torn. 
   • The ribbon is not recognised.

Check the condition of the ribbon in the
printer. If you have a print job in progress,
this restarts with a new card.  

PRINTER COVER OPEN

   • The printer cover is open.

Close the cover again. The printer starts up.

PRINTER READY

   • The printer is ready to receive data.

PROCESSING

   • The printer is receiving data.

MECHANICAL ERROR

   • Card jammed in the printer.
   • Mechanical component fault.

Open the cover and hold down the power
button in  order to eject the jammed card. 
If the problem persists, contact tech support.

OFF

STEADY LIGHT

FLASH ING
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WI-FI IS ON (optional)

   • The wireless (wi-Fi) connection is enabled. 

The printer is ready to be used.

COOLING MODE
The cooling system has been activated.
The printer pauses for a few seconds and
restarts once it has returned to its normal
operating temperature.

ADVANCED CLEANING

   • The printer requires advanced cleaning.

(See “Advanced cleaning”, page 55).

REGULAR CLEANING
(after 1,000 cards have been inserted)

   • The printer must be cleaned.

(See “Regular printer cleaning”, page 51).

FIRMWARE UPDATE

   • The printer is updating its firmware.
     The printer restarts following the upate.

CLEANING
(after 1,200 cards have been inserted)

   • The printer must be cleaned to avoid the
     the risk of warranty being voided.
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LCD screen
LCD screen is touch-sensitive: it enables easy interaction with the printer. 

Useful messages on the printer processes are displayed. 

They enable you to take actions and perform a good supervision of the printing jobs.

There are various types of statuses:

• Green: the printer is ready to print or in the process of printing, encoding, cleaning, etc.

• Orange or red: processes cannot be performed due to a small or serious issue
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Scan the flash code to access information on idville.com to solve the issue. 

• Red: processes cannot be performed due to a serious issue. The user action is needed:

Scan the flash code to access help

Launch the process again

Cancel the process

NOTE For more information, refer to the LCD screen user guide .
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Pop-ups 

NOTE Interrupting the pop-ups service is only recommended if there is a conflict with other applications
installed on the computer. The pop-ups service is the best way to properly monitor the printer
from your workstation.

ID Maker Infinity ID Maker Infinity

Get additional help on idville.com

IDville Premium Suite offers a service allowing the printer to communicate with the user through notifications.
There are several type of notications:

   • Messages about the maintenance of the printer.
   • Messages and alerts associated with ribbons, their compatibility or the nature of your print requests.
   • Warnings about problems which have stopped the printer

When the IDville Premium Suite is active, a small icon is displayed in the bottom right of your screen.
The color of the icon varies according to the status of the printer:

   • Green: Printer ready.
   • Orange: Information message issued - printing stopped.
   • Red: Warning message issued - printing stopped.
   • Grey: Printer in hibernation mode, disconnected or communication is interrupted.

When a notification is issued, it is displayed in a window of the following type:

User Preferences then untick the Enable notifications button.
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4. ADVANCED FEATURES
AVAILABLE OPTIONS
Options may be already integrated in the printer or provided separately. In this case, their shipped kits contain all
instructions for installation. Refer to the driver User Guides for all settings linked to these two possibilities.

Basic internal locking Encoding stations

Duplex activation

(double-sided printing)

200-cards extension feeder

Wi-Fi network

Scanning Kineclipse

Lamination module
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An extension for the feeder can be installed on Infinity. The standard version of Infinity has a feeder that can 
hold 100 cards. When the extension is installed, the feeder can hold 200 cards. 

!
Remove all cards from the feeder before performing the installation.
Unplug the printer before performing the installation.
Keep the feeder weight. It is needed to go back to the standard version.

  

4. Insert the extension until
    you hear a click.

5. Insert cards in the feeder.
    Put the weight on top of the
    cards. Close the door of the
    feeder. Plug the printer.

6. The 200-cards extension is
    installed and the printer is ready
     to be used. 

1. Fully open the feeder. 2. Open the cover. Insert the
    block to hold the  upper feeder
    in place as shown and then close
    the cover. 

3. Remove the feeder weight
    as shown.
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The frequency of Wi-Fi network must be compatible with the printer Wi-Fi card:

• Connect1: 2.4 GHz

• UBox: 2.5 GHz/5 GHz

Wi-Fi icon

LEDLCD

1. To configure the printer in Wi-Fi, contact the support team.
2. Check the availability of a Wi-Fi network.
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USING THE UV EFFECT WITH THE OVERLAY PANEL

This addition of layer adds an extra level of security to your cards:

• With the standard color ribbons ( YMCKO, 1/2 YMCKO, YMCKOK, 1/2 YMCKOKO) combined to lamination

!
Lamination is mandatory to protect color printing.

• With the YMCKOO ribbon (no lamination required)

!
The UV effect settings are only activated when the adequate ribbon is inserted into the printer.

1. From IDville Premium Suite, go to Printer Settings  and select Printing>Overlay>UV effect. 

2. 
• Among generic designs proposed in the list
• Your own custom design

Fixed Data Dynamic Data

Data inserted are the same on all cards (e.g., a 
company logotype). The insertion is performed
through the EPS 

Data inserted are different on each card (e.g. a picture).
The insertion is performed in ID Maker software
(>XL version)

Rendering on the card.

3 Apply lamination on the card if necessary.
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Overlay settings
Overlay settings can be adjusted in the IDville Premium Suite.

• The overlay can be applied on the whole surface of the card

• The overlay can be disabled (when lamination is applied for example)

• The overlay can be applied only on some areas of the card

• Two layers of overlay can be applied (with the YMCKOO ribbons).

NOTE Two layers of overlay increase protection against wear and tear  

Activation key
A simplex printer (prints only on one side) can be upgraded into a duplex printer (prints on both sides).

To obtain the activation key for that upgrade, contact your IDville dealer.

Proceed as follows:

1 Turn the printer on 2 Open the printer cover.

3 Remove the ribbon 4 Insert the key as shown
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5 Close the cover 6 
until the end of the process. 
The LED or L CD panel gives 
information about the process. 
The printer restarts at the end 
of the update.

7 Open the cover and remove the 
activation key

8 Insert the ribbon

9 10 Close the cover If necessary, a wizard is available in IDville Premium Suite
to perform the activation. 

The ON/OFF button flashes
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Double-side printing with a simplex printer
In case the double-side printing feature is not activated on your printer, proceed manually as follows: 

1  2   3  

The rewrite feature enables to erase and print, on rewritable cards only. 

Thanks to the inner color layer of the rewritable card, there is no need to use the ribbon for 
the rewrite feature. 

1 Remove the ribbon and close the printer cover.

2 Open the feeder and insert rewritable cards. 
      If other cards are already inserted, remove them from the feeder. 

3 From IDville Premium Suite, go to Printer Settings>Printing>Rewrite. 

4 Select Rewrite>Rewrite option, then the type of card:

PVC body that may be blank 
or pre-printed

Thermo-sensitive layer that 
contains ink which can be 
either revealed or hidden, 
depending on the setting 

5 Select the printing mode:
• Erase /rewrite (previous data on the card are erased before printing): the full surface of 

the card

• 

• Write only: there is no erase of the card before printing
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LAMINATION MODULE

!

Description of the lamination module

Access to the side panels of the machine and the option module fitting/removal areas is restricted
to your retailer/installer or to experienced users. Always disconnect the machine from the power-
supply (unplugged) before performing any work on it.

Printer LEDs
Lamination Module LEDs

Cards and ribbon

Cleaning

Lamination Module or 
Printer

See “ Interacting with 
the lamination module”, 
page 39.

B

A 

C

D 
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F Output Hopper

A Lamination Module

B Infinity Printer

C Control Panel

D Space for output hopper

E

F

G

L

M
N

H

I

J

K

E Location for security locking

F Platform for lamination module installation 

G Heating head 

H Axles

I Jam-clearing wheel

J Card leveler

K 

L Power cable socket

M Serial number label
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Installation of the lamination module

!

1  2  3  

4
 

5
 

Place the printer on the installation
platform (”Printer” side).

Connect the printer power-
supply and USB cable. See
“Connecting the Printer
Power Supply Cable”, page
11 and see “Installing”, page 12.

Place the lamination module on
the installation platform
(”Laminator” side).

Make sure that infro-red connectors
are facing each other and the two
modules are aligned.

Connect the lamination module
power supply cable.
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Once the printer and lamination module are connected, follow the instructions to power the machine on.

1 Plug the lamination module to an earthed power socket

2 Plug the printer to an earthed power socket

3 Connect the printer USB cable to the computer
The system is powered on: the Infinity Lamination control panel lights up showing that the machine is working properly.

NOTE

Make sure the card thickness gauge is well adjusted on the printer. See “Adjusting card thickness”, page 17.

Inserting cards and ribbon
See “Ribbons”, page 14 and See “ Inserting Cards”, page 15.

To save energy, the printer and the lamination module automatically switch to standby mode after 10
minutes of inactivity. They switch to hidermation mode after 30 minutes in standy mode.

The standby setting can be configured in the IDville Premium Suite. In standard standby mode, sending
a print request restarts the printer and briefly pressng the control button (for 1 second) takes the printer
out of hibernation mode.
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1 Push the door button to open the lamination module door

2 

3

2

 Close the lamination module door
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Removing laminated cards

  edis raer eht ta reppoh tuptuo eht otni deussi era sdrac eht ,etelpmoc si elcyc noitanimal dna tnirp eht ecnO
of the lamination module. This output hopper is designed to collect the printed cards that are laminated and/
or encoded. 

The capacity of the output hopper is 100 cards maximum with 0.76mm (30mil) thickness. 

Interacting with the lamination module
Although the lamination module was designed to operate independently and keep user involvement to a minimum,
it may prove useful to be aware of the main warning messages.

Control button

Cards and ribbon
Printing module

Cleaning
Printing module

Information
Printing module

Cards and film
Lamination module

Cleaning
Lamination module

Information
Lamination module OFF

STEADY LIGHT

FLASH ING

LEGEND
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NOTE

PRINTER AND LAMINATION MODULE READY

   • The printer is receive data.

   • The lamination module is ready.

The printer may be equipped with an LCD screen instead of the control panel. Refer to the LCD screen user guide

for more information.

RIBBON

   • No ribbon in the printer.

   • End of ribbon.

   • The ribbon is not correctly fitted.

   • The ribbon is torn.

   • The ribbon is not recognized.

Check the condition of the ribbon in the printer.

If there is a print job in progress, it restarts with a

new card. 

CARDS

   • No cards in the card feeder.

Reload cards into the feeder - the process starts

again.

   • Error loading cards.

Check the cards loaded. For any other problems,

contact tech support for assistance.

FILM
   • No film in the lamination module.
   • No more film.
   • The film is torn.
   • The film is not recognized.
Check the condition of the film in the printer.

PROCESSING
   • The printer is receiving data.
   • Lamination in processs.

PRINTER COVER OPEN
   • The printer cover is open.
Close the cover again. The printer
restarts.

MECHANICAL ERROR
   • Card jammed in the printer.
   • Mechanical component fault.
Open the cover and hold down the control
button to eject the jammed card.
If the problem persists, contact tech support
for assistance.

LAMINATION MODULE DOOR
   • The door of the lamination module is open.
Close the door. The lamination restarts.

MECHANICAL ERROR
   • Card jammed in the lamination module.
   • Mechanical component fault.
If the problem persists, contact tech support
for assistance.
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 ADVANCED CLEANING OF THE LAMINATOR
   • The lanimation module requires advanced
      cleaning.
See “Lamination module cleaning”, page 59

FIRMWARE UPDATE OF THE LAMINATOR
   • The lanimation module updating its firmware.
The printer is operation again after the update.

REGULATING TEMPERATURE
   • The lanimation module heats up for a few
     seconds and is reactivated when the required
     temperature is reached.

COOLING MODE
   • The cooling system has been activated.
The printer pauses for a few seconds
and restarts once it is back at its normal
operating temperature.

CLEANING OF THE PRINTER
(after 1,200 cards inserted)
   • The printer must be cleaned to avoid
     the risk of the warranty being voided.

FIRMWARE UPDATE OF THE PRINTER
   • The printer is updating its firmware.
The printer is operational again after the
update.

WAITING FOR CARD INSERTION OR REMOVAL
   • The printer is waiting for a card to be
      inserted or removed.
Insert a card or remove the card from the
manual feeder.

ADVANCED CLEANING OF THE PRINTER
   • The printer requires advanced cleaning.
See “Advanced cleaning”, page 55.

REGULAR CLEANING OF THE PRINTER
(after 1,000 cards inserted)
   • The printer must be cleaned.
See “Regular printer cleaning”, page 51.
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ENCODING OPTIONS
Encoding systems are used to customize magnetic stripes, and contact and contactless smartcards.

It is possible to install up to three types of encoder in the printer (magnetic stripe, contact and contactless smartcards)
on your premises.

Magnetic stripe encoding

The IDville encoder encodes the magnetic stripes in a single pass then runs a data check.

Location of the magnetic encoder

To install the magnetic encoding station:

1 Refer to the instructions provided in the kit 

2 

!
Use only magnetic stripe cards that comply with ISO 7810 and ISO 7811 standards.
The magnetic stripe must be moulded into the card to work properly.
Never use cards with a glued-on magnetic stripe.

Access the settings through Printer settings>Encoding>Magnetic .

Configure stripes to select the desired format for each stripe, according to the following table.

ISO 7811 magnetic encoding standards

Use the installation wizard that is available in IDville Premium Suite>Assistance & Maintenance>Maintenance>
Printer Options .

The magnetic encoder is a module installed either in the factory or on site by the user. The read-and-write head is
located under the path taken by the cards and before the print head. The encoding sequence for a card is always
carried out before the printing.

Although able to be configured as high coercivity (HiCo) or low coercivity (LoCo) by a simple click in the EPS properties,
IDville magnetic encoders come factory-set for high coercivity (HiCo).
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1 Dots per inch
2 Except for the “?” character
3 Including the Start, Stop and LRC

characters. These characters are
handled automatically by the
magnetic encoder.

Cleaning the magnetic encoder

Use the installation wizard that is available in IDville Premium Suite>Assistance & Maintenance>Maintenance>
Printer Options .

The magnetic encoder is a module installed either in the factory or on site by your IDville dealer. The read-and-write
head is located under the path taken by the cards and before the print head. The encoding sequence for a card is
always carried out before the printing.

The magnetic encoder head requires regular maintenance in order to ensure the integrity of the data encoded onto
cards. Cleaning of the magnetic encoder is performed when the printer runs an advanced cleaning sequence with
T-cards. 

Repeatedly running the cleaning card through the printer cleans the card feed roller, the cleaning rollers,
the print head and the magnetic encoder read-write head.

If, in between two regular printer cleaning runs, the read-write process fails with more than one card, it is
recommended to run an advances printer cleaning sequence manually.

• Coercivity sets the magnetic encoding to high (HiCo) or (LoCo) coervicity. A magnetic stripe that is encoded with
   high coercivity is more resistant to external disturbance than a magnetic stripe encoded using low coercivity.

• Encoding via an application is used to encode magnetic stripe cards from application such as Word for example.
   A text field enclosed within “|” and “|” characters (or some other character which the user can define) will be
   interpreted as an encoding command by print driver.

• Select Assistance & Maintenance>Tools and Diagnostic>Support tools>Encoding to directly encode one or more
   magnetic stripes: select each track and enter the data to encoded according to the configuration of the stripes.
   Click on the Encode track(s) button to run the encoding cycle.

Stripe # Separator Density Character set
Number of
characters

STRIPE 1 ^ 210 ppp1 Alphanumeric
(ASCII 32-95)2

793

STRIPE 2 = 75 ppp1 Numeric
(ASCII 48-62)2

403

STRIPE 3 = 210 ppp1 Numeric 1073
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SECURITY OPTIONS

Digital Erasing
This feature is used to erase data of printing jobs from the printer memory. It is used for security reasons. 

1 Before launching a printing job, go to Printer Settings>Security and 
activate Data used for printing checkbox.

2 Launch the printing job. 

Kineclipse
This feature is used to erase data that is visible on the monochrome and overlay panels of the ribbon.

1

 

Before launching a printing job, go to IDv i l le  Premium
Suite>Printer Settings and activate Hide the data printed
on the ribbon.

When the feature is activated, data of all
future jobs is erased from the printer memory.

Launch the printing job.2

 

NOTE 2 keys are provided in the option package

NOTE Scanning, digital erasing, kineclipse and locking options are integrated in the printer. There is no need
for on-prermises installation.
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Scanning a printer card (on both sides) is used for the following purposes:

• Have a record of printed cards.

• Tracking and fraud questions (e.g.: making sure that cards are not printed for personal or wrong purposes).

• Proofs of printings (may be useful in case of litigation), etc.

• Optical character recognition capacity to extract textual data (e.g. a barcode) and perform associated actions:

  automatic creation of user accounts, comparison and check of data and/or identity of the card owner, adding of

  security elements (ex: UV printing of the OR value read on the overlay panel). Images that can be retrieved are in

  PNG, JPG and BMP formats.

• Checking the QR code printed on the card.

• Checking of the card rewrite (for certification reasons).

 

Security locking
This option enables to attach the printer with a physical cable.

SCANNING

 

 

 

 

Some scanning parameters may be changed:

• Resolution, 

• Picture format, 

• Scan mode (color, monochrome).

NOTE The scanning option and the contact smartcard encoding station are not compatible.
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COLOR PROFILE

! The procedure is different according to the Operating System and the computer brand.

On a Windows computer 

>Printer settings>Printing>Colors>Color settings

 and click on Do not apply .

On a Macintosh computer

1 Go to Applications>Utilities>ColorSync Utility .

2 From the list on the left, click on the printer. 

3 Other

4 System>Library>ColorSync>Profiles>IDville_profile

5 
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5. MAINTENANCE

Any failure to follow the maintenance and servicing procedures described in this section voids the print head warranty.
IDville declines any liability where there has been a failure to perform required maintenance on the printer.
The print head is a wearing part and an extremely sensititve printer componenet. Its lifespan can be seriously curtailed
by the presence of dust, liquids or solids in the printer’s immediate environment, on the print head or on the cards.
Users must take all necessary precautions to insert only clean cards, free of dust deposits or foreign bodies, into the
printer. The frequency and quality of cleaning are decisive factors enabling users to extend the print head’s lifespan
and to ensure excellent print quality. 

Particular care must be taken with cleaning. 

Users must comply with the servicing and maintenance instructions as fully described in this section. The IDville High-
Trust consumables have been exclusicely designed to work with the IDville card printers. Tested and validated by 
the IDville R&D and other Quality departments, these consumables bring you printing quality and reliability, maximizing
the lifespan of the print head. The use of consumables other than IDville High Trust may lead to bad printing quality
and a dsyfunction of the printer.

The manufacturer’s warranty does not cover physical damage or quality problems caused by using non-IDville approved
ribbons. IDville provides replacement parts and consumables that you can refer to by visiting the website at
idville.com

IDville printers are designed to last long and require minimal regular maintenance. Follow the following instructions to
ensure that the printer operates correctly.

!
The manufacturer’s warranty is subject to strict adherence to the regular servicing and maintenance
instructions, and in particular the printer cleaning cycles.
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REGULAR PR INTER CLEANING

Printer cleaning

NOTE Recommended cleaning cycle: whenever the ribbon is changed.
Mandatory cleaning cycle: when the cleaning warning is triggered.
Servicing accessory: adhesive cleaning card.

!
The cleaning warning system of the printer is triggered after a certain number of inserted cards.

Proceed with the regular cleaning of the printer as soon as the warning is triggered.

The print head warranty is directly linked to regular cleaning of the printer. If the regular cleaning
is no performed and if the warning light remains ON, the print head warrantly is automatically voided
due to a failure to comply with contractual maintenance obligations.

For more information, refer to the Cleaning kit safety datasheet.
Follow the procedure to ensure regular cleaning is performed properly:
Repeatedly running the adhesive card through the printer clean the cleaning roller in order to maintain print quality
and increases the service life of the print head.

Infinity 1000 cards 200 cards 1200 cards

Printer
Cleaning required after:
(warning light flashing)

Number of cards remaining
before warranty voided:
(warning light flashing)

Warranty invalid after:
(warning light steady)
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1 2 3

 

Open the card feeder. Remove the cards and using the lever, set the card thickness
to the MAX position.

Open the printer cover. Remove the ribbon Close the cover and press
until a click is heard.

 

4 5
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Double-click on the power button on the
control panel.

Remove the film from the adhesive card       and insert the
adhesive side up       . The cleaning starts.

6 7 

NOTE When the cleaning is over, the used adhesive card is ejected into the output hopper.
Before using the printer, remember to reset the gauge to the desired card thickness.
Cleaning can also be launched from the IDville Premium Suite properties by clicking on Start cleaning.

1
2
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To maintain the original print quality and to absorb surplus ink on the print head, we recommend that the print head
is cleaned regularly using the cotton buds supplied by IDville. Protect the print head and its components from any
discharge of static electricity.

Print head cleaning

NOTE Recommended cleaning cycle: every time the ribbon is changed.
Servicing accessory: cleaning swab impregnated with isopropyl alcohol.

!
Unplug the printer from its power supply before cleaning the print head.
Follow the cleaning cycles.

1 2

3 4  

NOTE Wait for 2 minutes after cleaning before using your printer.

Avoid any contact between the print head and any metal or sharp objects. This could permanently
damage the print head.

Avoid touching the print head directly with your fingers, as this could affect print quality or
permanently damage the print head.

Unplug the power supply, open the cover, and find the
print head.

Take an cleaning swab and press the middle
of the tube until the end of the cotton
bud is impregnated with alcohol.

Pull the protective cover up and gently rub the cotton
bud from left to right along the print head for a few
seconds.

Close the cover. Reconnect the printer.

click
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For a more in-depth clean, we recommend carrying out an advanced clean every five regular cleaning cycles.
IDville provides an Evoli High Trust maintenance kit consisting of 2 adhesive cards, 2 impregnated T-cards, a cleaning
pen and a box of wipes. The T-card is used to clean the card feed rollers and the magnetic encoder head.
To ensure advanced cleaning is performed properly, follow the instructions.

Open the printer cover. Remove the ribbon. Open the card feeder
on the printer.

Close the cover and press
until a click is heard

ADVANCED CLEANING

Printer cleaning

NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.

When the cleaning is over, the used adhesive card is ejected into the output hopper.

If a YMCKOO ribbon is used, clean the rollers with 1 or 2 cleaning swabs every 1000 cards.

Servicing accessory:

• Impregnated T-card

• Adhesive card

NOTE Wait for 2 minutes after cleaning before using your printer.

!
The T-card must be used just after the bag is opened.

1  2  3 4  
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Take the T-card and insert it into
the feeder as shown. Cleaning
starts.

Take the T-card and insert it into
the feeder as shown. Cleaning
starts.

Remove the film from the adhesive
card        and insert the adhesive card
into the feeder,        adhesive side up.
The cleaning starts.

Remove the cards and set the card thickness to the MAX
position.

Double-click the cleaning button on
the control panel before inserting the
cleaning card.

5 6  

7

 

8

 

9

 

1
2
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Pull the protective cover up and gently rub 
the pen from left to right along the print head.

Close the cover. Reconnect the printer.

Remove the cap of the cleaning pen. Unplug the power supply, open the cover, and find the print head.

Print head cleaning

NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.
Servicing accessory: cleaning pen

!
Unplug the printer from its power supply before cleaning the print head.
Follow the cleaning cycles carefully.

1  2 

3  

a few seconds.

4 

NOTE Wait for 2 minutes after cleaning before using your printer.

Avoid any contact between the print head and any metal or sharp objects. It could damage the print-
head.
Avoid touching the print head directly with your fingers, as this could affect print quality or permanently
damage the print head.
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Open the print cover.
Locate the dust filter.

Locate the dust filter. Remove the
filter by pulling it upwards and
slide it out to release it fully.

Take a cleaning wipe
supplied by IDville.

 

NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.
Servicing accessory: cleaning wipes.

1 2
 

3

Clean the filter by rubbing the wipe
over both sides.

Put the filter back. Insert it in its
slot (notch towards you) and lower
it until a click is heard.

Close the cover.4
 

5
 

6

click
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Lamination module cleaning

NOTE Recommended cleaning cycle: once a year or every 10,000 cards, depending on the work environment.
Servicing accessory: special adhesive cleaning card.

Follow the procedure to perform a lamination module cleaning.

1 

2

3

4

5

6

7

Remove lamination from the lamination unit.

Launch the lamination module cleaning wizard on the
IDville Premium Suite.

Remove the two protective films on both sides of the
special adhesive card.

Once the cleaning cycle is complete, the used card is
ejected from the printer.

Put the lanimation film back. (See “Inserting lamination
film” page 38.)

Close the door of the lamination unit. The printer is
ready to operate again.

Insert the adhesive card into the opening above the
output hopper at the rear side of the module. The
card goes inside the printer.
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NOTE Recommended cleaning cycle: every 5 regular cleaning cycles.
Servicing accessory: cleaning wipes.

1 Unplug the lamination module and disconnect it from the printer.

2 
3 

4 Take a cleaning wipe supplied by IDville.

5 
both sides.

6 

7
 

Put the filter back. Insert it in its slot (notch towards you)
and push it until a click is heard.

Reconnect the lamination module to the printer and
plug it back.
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Using the leveler
Use the levelers of the lamination module to correct any natural bending of the card caused by the lamination
process. Cards can be more or less misshapen depending on the type of card and film used. 

Follow the procedure below:

1 2 3 4

 

PVC Cards PET-F Cards PC Cards

1 mil transparent patch
Single-sided B A B

Double-sided B B B

1 mil holographic patch
Single-sided A A B

Double-sided B B B

0.5 mil transparent patch
Single-sided A A B

Double-sided A A B

0.6 mil holographic patch
Single-sided A A B

Double-sided A A B

Varnish
Single-sided A A B

Double-sided B B B

Holographic varnish
Single-sided A A B

Double-sided B B B

Open the door of the
lamination module.

Loosen the two
wheels as shown.

Depending on the type
of card and film used,
place the block support
on position A or B 
(see the table below).

Tighten the two
wheels and close
the door of the
lamination module.
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6. HELP
DIAGNOSTIC HELP
This section contains all information that could be needed to perform a few simple checks that your IDville dealer
may require.

Printing a technical test card
The technical test card must be printed when the machine is received to ensure your printer operates correctly.
This card shows various items of technical information concerning the machine (serial number, firmware, cleaning
operations, print head, etc). Your dealer may ask for those items of technical information. 

1 
2 Make sure that there is a ribbon and a card in the printer.

3 
4 Press and hold down the power button again.

5 The power button light comes on.

6 
7 

is fitted, and on both sides if the double-sided printing function is activated).

8 The printed card is ejected into the output hopper.

Printing a graphical test card
The graphic test card is used to check the print quality in color or monochrome, the offsets and the synchronization

 of the ribbon. To print the graphic test card, make sure there are a ribbon and a card in the printer.

Printing of the graphical and technical test cards can be launched from the menu displayed on the top-right part of 
the IDville Premium Suite.

Identifying installed software versions

1 In IDville Premium Suite, go to Assistance&Maintenance>Product information>Software version .

2 Click on Software versions .

55Call us at: 1.866.438.4553 or visit: idville.com



TROUBLESHOOT ING

Printing problems
Nothing prints

1 Check the print driver
• 

• Make sure that the printer is selected as the default printer.

2 Check the printer’s power supply
• Make sure that the power cable is correctly connected to the printer and to a working electrical socket.

• Make sure that the printer is on and that the power button is lit.

• Make sure the power supply unit supplied with the printer is being used.

3 Check the USB cable
• Make sure that the USB cable is well plugged on both ports of the printer. 

4 Check the ribbon
• 

5 Check the cards
• Make sure that there are cards in the card feeder.

• Make sure that no cards are jammed in the printer.

6 Print a test card
• See “Printing a technical test card”, page 62.

Blank card ejected

1 Check the ribbon
• 

2 The print head may be damaged
• Print a test card.

If the test card does not print, contact an IDville dealer for technical support or visit idville.com
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Poor print quality

Small blemishes on the card

• The card surface may be dirty.

Check that your cards are perfectly clean.

Use new cards.

• Cleaning roller or print head clogged.

Run a cleaning cycle.

Horizontal white lines

• 

Check that there are no wrinkles on the ribbon surface.

• The print head is dirty or damaged.

Clean or replace the print head.

Blurred image

• 

Check that the ribbon is correctly positioned in the printer.

• Poor ribbon synchronization.

Open and close the printer cover to synchronize the ribbon.

• Dirty printer or cleaning roller.

Clean the printer.

• Use of incompatible cards.

Check that the cards used match the specifications.
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Partial or incorrect printing

1 Check the interface cable
• If irregular characters are printed, make sure the USB cable supplied with the printer is being used.

• Try using another cable of the same type.

2 Check that the printer is clean
• Clean the printer, especially the cleaning roller.

• See “5. Maintenance”, page 50.

3 Check that the cards are clean
• Store the cards protected from dust.

4 Check the ribbon
• 

• Make sure that the ribbon moves correctly.

5 Check the print head
• If horizontal straight lines appear on printed cards, the print head may be dirty or damaged.

See “5. Maintenance”, page 50 and See “6. Help”, page 62.

If the problem persists, contact your IDville dealer or visit idville.com.

NOTE We recommend that you obtain your cards from an IDville dealer.
Use of cards obtained elsewhere is liable to adversely affect print quality and/or damage the
print head.
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Freeing jammed cards
Control panel displays:

MECHANICAL ERROR

 

A card is jammed in the printer. Print jobs are interrupted.

The printer light and the control button are ON.

!
Do not turn your printer off, as this cancels pending print jobs in the printer’s memory.

Remove the card as follows:

1 Open the printer cover and remove the ribbon.

2 Press the power button to activate the card feed rollers. If the card is still stuck inside the printer, slide it manually
towards the printer output. If there is more than one card, always push the top one first.

3 Replace the ribbon, then close the printer cover.

To prevent card jams:

1 Make sure that the card thickness gauge is correctly adjusted.

2 
3 
4 
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Replacing the print head

NOTE For more information on print head warranties, refer to the IDville warranty available on 
idville.com .

!
Unplug the printer before replacing the print head.
Avoid touching print heads with bare hands.
Follow the instructions carefully.

Removing the defective print head

1 Open the printer cover.

The print head is a sensitive component of the printer, It determines the print quality. A regular cleaning and an
environment free from dust or other particles ensure a lengthy useful life. See “Print head cleaning”, page 54 to
clean the print head. In case the user needs to replace the print head, IDville designed a unique device that requires
no tools for the replacement.

Before replacing the print head, contact your IDville dealer. The dealer can give advice and supply a new print-
head if necessary.

2 Locate the print head.

Press on the plastic part behind the print head
(pressure plate).

Pull on the print head with the other hand
as shown to free the lugs from the holding fork.

Remove the lugs from their slots.

Tilt the head carefully downwards and disconnect
the connector linked to the cable. Avoid forcing
the mechanism.

3

4

5

6
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Installing the new print head

7 Note the code (PKN number)
on the white label of the print
head. This code is needed later
in the procedure.

8  Take the new print head and insert
it vertically (white connector
upwards), raising the fork in their
slots       . Then lower it by pressing
the two forks       , a click will be
heard.

1
2

9 

10 The new print head is installed. 11  

Connect the cable into its socket,
making sure it is the right way around.
Do not use any force, as this part is
relatively fradile. Press down on each
side of the connector to ensure a 
good connection is made.

click
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Configuring the new print head

12 

13
 

14
 

!

Cleaning the printer

The “CLEANING ” light is ON  on the LED panel.

Once the cleaning of the print head is done, the printer is ready to be used.

!
Cleaning is absolutely necessary after changing the print head. No print jobs can be run until the cleaning
operation has finished. See “Print head cleaning”, page 54.

Power on the printer and make sure that it is properly connected to a computer on which the IDville Premium Suite
is installed.

From IDville Premium Suite, go to Assistance and Maintenance>Maintenance>Print head replacement.

Enter the PKN number of the print head kit in Enter PKN No. (noted in step 7). Then Validate PKN.

If the PKN number is not entered correctly, printer malfunctions may occur and the warranty may
be voided.

62Call us at: 1.866.438.4553 or visit: idville.com



An update of the firmware that is not properly performed may result in a malfunctioning printer.
Before updating the firmware, contact your IDville Dealer.
Firmware updates are only required in case of an issue or a mulfunction clearly identified by your IDville
Dealer.
Interrupting the transfer between computer and printer during the download phase (powering off the
printer or computer, unpluging a cable) would make it impossible to restart the printer. If such an incident
occurs, contact your IDville dealer to replace the printer’s processing board.

Download the file (.firm) from idville.com.

Download the file (.firm) from idville.com.

Open IDville Premium Suite and double-click on the name of the printer. Go to Assistance and maintenance>Software-
updated/Printer firmware>Start the updates wizard.

Follow the instructions and select the file .firm that was just downloaded.

The operation may take up to 1 minute. When the firmware is installed, the printer restarts. The update is complete
and the printer is ready for use.

If the printer is not showing a Ready status, this means that the update was not performed correctly or, that the pirnter
is not working properly. Check the connection cables and run a new update.

Go to Menus & preferences, Printer and scanners, and select your printer. Go to Options & Supplies. Utility and click
Open printer utility. The IDville Card Printer window opens. All you need to do now is click on Upgrage.

Select the folder where you extracted the downloaded file and open the firmware file (.firm).

When prompted by the program, follow the instructions in order to select the printer and start the operation.
The firmware transfer is in progress.

After about thirty seconds, the firmware is transferred to the printer and the operation is complete.

Check the firmware version by clicking on Identify.

If the printer is not showing a Ready status, this means that the update was not performed correctly or, that the
printer is not working properly. Check the connection cables and run a new update.

!

On Windows

1  

2 

3
 

4
 

5

 

On Macintosh

1 
2

3

4

5

6

7

NOTE In case of problems during the update of the firmware on Windows or Macintosh, contact your IDville
dealer who can provide a new installation file for the firmware.
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Updating the print driver

! Before any update, contact your IDville dealer for advice or guidance on performing the update.

1 idville.com

2 
3 
4 
5 

NOTE The print driver can also be updated in the IDville Premium Suite.
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TECHNICAL SUPPORT

If you do not manage to solve your problem, you can obtain further information and help from the IDville partner 
network.

Finding information on idville.com
If additional technical help is needed, information on using and troubleshooting IDville printers is available on 
idville.com.

• 

• Print drivers

• User manuals

• Videos about using and maintaining ID Maker printers

• 
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7. DECLARATIONS OF CONFORMITY

GENERAL

Concerning Safety and Electromagnetic Compatibility of Radio Equipment 
(RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives) and (RoHS3) 
2015/863/EU:

Manufacturer name:  Evolis

Manufacturer address:  14, avenue de la Fontaine
 Z.I. Angers Beaucouzé

 49070 Beaucouzé, France

Equipment name:  Primacy 2

Year of manufacture:  2022

I, the undersigned,

Laurent Godard , 

Declare under my own responsibility that the product here above described 
complies with the essential applicable requirements, (particularly with those of 
the RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives and (RoHS3) 
2015/863/EU as follows:

Article 3.1 a: (electromagnetic compatibility protection requirement)

Safety standard applied  EN62368-1: 2014

 EN50364: 2010

Article 3.1 b: (electromagnetic compatibility protection requirements)

EMC standard applied  EN55032: 2012

 EN55024: 2010           

 EN61000-3-2: 2014

 EN61000-3-3: 2013

 EN301489-3: 2013 (VI.6.1)

Article 3.2: (Good use of the radio frequency spectrum to avoid undesirable interferences)

EMC standard applied  EN300330-2 V1.6.1

Full name: Laurent Godard

Position: R&D Director

Date: January 4 th 2022

Signature:  

EUROPE  - Norway Only: This product is designed for IT power system with phase-to-phase voltage 
230 V. Earth grounding is via the polarised, 3-wire power cord.

FI: “Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan”

SE: “Apparaten skall anslutas till jordat uttag”

NO: “Apparatet må tilkoples jordet stikkontakt”

DK : „Apparatets stikprop skal tilsluttes en stikkontact med  jord, som giver forbindelse til 
stikproppens jord“.

I

FCC Statement (For U.S.A.)

Federal Communications Commission Radio Frequency Interferences Statement

A, Section 15.107(a) and Section 15.109(a) Class B digital device.

Supplemental information:

pursuant to part 15 of the F CC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this requirement does cause harmful 
interference to radio or television reception, which can be determine by turning the equipment off 
and on, the user is encouraged to try to correct the interference’s by one or more of the following 
measures: 
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
- Consult the dealer or an experienced radio/TV technician for help.
Use of a shielded cable is required to comply within Class B limits of Part 15 of F CC Rules.

expressly approved by Evolis may cause, harmful interference and void the F CC authorization to 
operate this equipment.
t is recommended to respect a distance of 20 cm between user and RF ID module when the 

module is powered. 
This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject 
to the following two conditions: (1) this device may not cause interference, and (2) this device must 
accept any interference, including interference that may cause undesired operation of the device.

VCCI (For Japan)
This is a Class B product based on the standard of the Voluntary Control Council for Interference 
from Information Technology Equipment (V CCI). If this is used near a radio or television receiver in 
a domestic environment, it may cause radio interference. Install and use the equipment according 
to the instruction manual.
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Concerning Safety and Electromagnetic Compatibility of Radio Equipment 
(RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives) and (RoHS2) 
2011/65/EU:

Manufacturer name:  Evolis

Manufacturer address:  14, avenue de la Fontaine
 Z.I. Angers Beaucouzé

 49070 Beaucouzé, France

Equipment name:  Primacy 2

Year of manufacture:  2022

I, the undersigned,

Laurent Godard , 

Declare under my own responsibility that the product here above described 
complies with the essential applicable requirements, (particularly with those of 
the RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU directives and (RoHS2) 
2011/65/UE as follows:

Article 3.1 a: (electromagnetic compatibility protection requirement)

Safety standard applied  BS-EN62368-1 : 2014

 BS-EN50364:2010

Article 3.1 b: (electromagnetic compatibility protection requirements)

EMC standard applied  BS -EN55032: 2012

 BS -EN55024: 2010           

 BS -EN61000-3-2 ; 2014

 BS -EN61000-3-3 : 2013

 BS -EN301489-3 : 2013 (VI.6.1.)

Article 3.2: (Good use of the radio frequency spectrum to avoid undesirable interferences)

EMC standard applied  BS-EN300330-2 V1.6.1

Full name: Laurent Godard

Position: R&D Director

Date: January 4 th 2022

Signature:  

EUROPE  - Norway Only: This product is designed for IT power system with phase-to-phase voltage 
230 V. Earth grounding is via the polarised, 3-wire power cord.

FI: “Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan”

SE: “Apparaten skall anslutas till jordat uttag”

NO: “Apparatet må tilkoples jordet stikkontakt”

DK : „Apparatets stikprop skal tilsluttes en stikkontact med  jord, som giver forbindelse til 
stikproppens jord“.

FCC Statement (For U.S.A.)

Federal Communications Commission Radio Frequency Interferences Statement

A, Section 15.107(a) and Section 15.109(a) Class B digital device.

Supplemental information:

pursuant to part 15 of the F CC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this requirement does cause harmful 
interference to radio or television reception, which can be determine by turning the equipment off 
and on, the user is encouraged to try to correct the interference’s by one or more of the following 
measures: 
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
- Consult the dealer or an experienced radio/TV technician for help.
Use of a shielded cable is required to comply within Class B limits of Part 15 of F CC Rules.

expressly approved by Evolis may cause, harmful interference and void the F CC authorization to 
operate this equipment.
It is recommended to respect a distance of 20 cm between user and RF ID module when the 
module is powered. 
This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject 
to the following two conditions: (1) this device may not cause interference, and (2) this device must 
accept any interference, including interference that may cause undesired operation of the device.

VCCI (For Japan)
This is a Class B product based on the standard of the Voluntary Control Council for Interference 
from Information Technology Equipment (V CCI). If this is used near a radio or television receiver in 
a domestic environment, it may cause radio interference. Install and use the equipment according 
to the instruction manual.
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